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Bedienungsanleitung fiir den eLogger V3

Patent beantragt

Dokument Version 1.3, Model # MPRV3-CONN-100, MPRV3-LEADS-100 und MPRV3-LEADS-150

Danke, dass Sie sich fiir den eLogger entschieden haben! Diese Anleitung fiihrt Sie durch die Installation und Bedienung
des eLogger.

Bitte lesen Sie die Anleitung sorgféltig durch bevor Sie fortfahren! Falls nach dem Studium dieser Anleitung -einschlieBlich des
Abschnitts ,Fehlerbehebung” - noch Fragen offen sind, besuchen Sie bitte unsere Webseite
www.eagletreesystems.com/support/support.html fir zusatzliche Unterstiitzung (in englischer Sprache).

Die aktuelle Version dieser Bedienungsanleitung befindet sich auf unserem Server im Bereich SUPPORT als PDF-Datei.

Flllen Sie bitte auch das Registrierungsformular am Ende dieser Anleitung aus, falls Sie den eLogger nicht direkt bei Eagle Tree
Systems erworben haben. So kdnnen wir Sie mit neuesten Informationen auf dem Laufenden halten.

Hauptmerkmale

Die wichtigsten Merkmale des eLogger:

B Strommessung bis zu +/- 100 Ampere (150 A mit MPRV3-LEADS-150) und
Spannungsmessung von 5 Volt bis 70 Volt

H Strommessung erfolgt mit Halleffekt-Sensoren und NICHT mit Shunt-Widerstanden wie
bei anderen Gerdten am Markt - das bedeutet volle Spannung an lhrem Modell, kein
Leistungsverlust!

B Auch zur Messung bei der Akkuladung geeignet!

H Direkter Anschluss des PowerPanel LC-Display moglich

W Optionaler Anschluss von bis zu drei Temperatursensoren, Drehzahlsensor (Brushless,
magnetisch oder optisch), Fluggeschwindigkeit, Hohenmesser, GPS, Servo-Strom, Position
des (Gas)-Servos und mehr.

H Einstellbare Aufzeichnungsrate (Logging Speed) von 1 bis 10 Messungen/Sekunde und
verlustlose Datenkomprimierung fiir lange Einsatzzeit/Aufzeichnungsdauer

H Vier mal soviel Speicher wie beim eLogger V2. Alle Daten werden in einen permanenten
Speicher geschrieben, der die Daten auch ohne Stromversorgung behalt

H Die Software berechnet Leistung (W), Kapazitdt (mAh) usw.

B Kompatibel mit Windows XP, Vista, 98SE, ME und Win2000

M Integrierte ECHTE USB Schnittstelle inklusive Kabel (Kein USB/RS232 Wandlerkabel
wie bei anderen Loggern)

B Wiegt ca. 20 Gramm. Version mit Anschlusskabel wiegt 5 g mehr

B Unterstiitzt USB Live-Modus zur Echtzeit-Anzeige der Messdaten am PC!

B Windows Software fiir Virtual Playback (Wiedergabe der aufgezeichneten Messdaten)
und grafische Darstellung der Messdaten im Lieferumfang

W Die Grafiksoftware bietet umfangreiche Darstellungsméglichkeiten
(z.B. Diagramme von Strom- und Spannungsverlauf)

B Update der Firmware iiber das Internet moglich. Einfach die neueste Datei downloaden
und damit den eLogger updaten.

H Unterstiitzung von metrischen und englischen Einheiten
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Bedienungsanleitung eLogger V3

BestimmungsgemdiRe Verwendung

Der eLogger wurde fiir die Verwendung in unbemannten, ferngesteuerten Modellen entwickelt. Die Verwendung des eLoggers fiir
andere Zwecke wird ausdriicklich nicht unterstiitzt. Des Weiteren ist die Verwendung des eLoggers in Umgebungen/Situationen
ausdriicklich verboten, in denen eine Fehlfunktion zur Verletzung von Personen, Tod bzw. Schadigung von fremdem Eigentum fiihren
konnte.

Verpackungsinhalt

In der Verpackung sollte sich folgendes befinden: eLogger (entweder mit Anschlusspins oder Anschlusskabeln), USB Kabel, CD-Rom.

Ndichste Schritte
Die Installation bzw. Benutzung des eLoggers ist sehr einfach, wie die nachfolgende, schrittweise Anleitung zeigt:
1. Bitte lesen Sie die Anleitung, um sich mit den Warnungen, den Messwerten die Sie erfassen mochten etc. vertraut zu machen.

2. Bauen Sie den eLogger in Ihr Modell ein, wie es im Abschnitt eLlogger Installation beschrieben wird. Beachten Sie dabei unbedingt die
Polaritdt und die Steckrichtung der Sensoren, da manche der Stecker in mehreren Positionen passen!
3. Installieren und konfigurieren Sie die Windows Software wie im Abschnitt,Softwareinstallation” angegeben.

4. WICHTIG: Testen Sie lhr Modell vor der Verwendung wie im Abschnitt Einsatz des eLogger beschrieben!

Installation des eLogger

WICHTIG: Verhindern Sie jede Beriihrung der Kontakte am eLogger (USB oder Sensorkontakte) mit Anschliissen Ihres Akkupacks,
anderen Platinen oder dem Motorgehause!! Falls dies dennoch geschieht, kann der eLogger auf Grund der eventuell anliegenden
Spannungen zerstort oder beschadigt werden. Es besteht in diesem Fall der Beschadigung/Zerstérung KEIN Garantieanspruch!

Die nachfolgenden Beschreibungen / Zeichnungen fiihren Sie durch die Installation des eLoggers.

Anschluss des eLoggers an die Stromversorgung lhres Modells

WARNUNG: Hohe Spannungen kénnen zu elektrischem Schlag fiihren! Seien Sie extrem achtsam beim
Umgang mit Akkupacks, die eine hohe Ausgangsspannung haben. Arbeiten an spannungsfiihrenden
Teilen erfolgen auf Ihr eigenes Risiko!

Der eLogger wird mit seinen Batt Anschliissen an ihren Akkupack angeschlossen. Die Leitungen, die mit ESC (=Controller) beschriftet
sind, werden an den Controller-Eingang angeschlossen. Die roten Leitungen der bedrahteten Version des eLogger miissen dabei an
den Pluspol des Akkupacks (bzw. Controllers) angeschlossen werden. Fiir Messungen wahrend des Ladens des Antriebsakkus diirfen
die Anschliisse am E-Logger (BATT und ESC) nicht vertauscht werden. Der Strom fliel3t beim Laden zwar ,in die andere Richtung’, wird
aber trotzdem korrekt gemessen! Das Ladegerat wird also an die Anschliisse ESC angeschlossen - der Akku bleibt immer auf
BATT.

WICHTIG: Bitte klemmen Sie die Stromversorgung lhres Modells immer ab, wenn dieses nicht in Benutzung ist!

WICHTIG:
Bei Verwendung des eLoggers mit Steckkontakten stellen Sie bitte vor Benutzung sicher, dass die Stifte nicht verbogen oder
beschadigt sind. Falls ein Kontaktstift verbogen/beschédigt ist, kann es beim Aufschieben des Verbindungssteckers ansonsten

zu Kurzschluss oder Unterbrechungen des Kontaktes fiihren. Dies kann im schlimmsten Fall eine Zerstérung / Beschadigung des
eloggers verursachen.
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Temperatur. messung mit dem eLogger

Bis zu drei optionale Temperatursensoren kénnen an den eLogger angeschlossen werden.

Die Temperatursensoren werden installiert, indem man die ,Drahtschleife” um den Akkupack, Motorcontroller (bzw. dem Objekt,
dessen Temperatur erfasst werden soll) legt und mit den beiden Gumminippeln an der zu messenden Oberfldache fixiert.

Der Micro-Temperatursensor kann mit Klebeband - oder auch mit Schrumpfschlauch z.B. direkt am Akkupack - fixiert werden.
Verbinden Sie jeden Temperatursensor wie in Abbildung 1 gezeigt mit dem eLogger.

Hinweis: Das Anschlusskabel der Temperatursensoren kann mit einem Standard-Servokabel einfach verlangert werden.

Drehzahlmessung mit dem eLogger (mit Hallsensor/Magnet)

Hinweis: Bei Verwendung des Brushless oder optischen Drehzahlsensors lesen Sie bitte den entsprechenden Abschnitt.

Die Installation des optionalen Hall-Drehzahlsensors und der zugehérigen Magnete ist der Aufwéndigste Teil der Installation, aber
relativ einfach zu bewerkstelligen, wenn eine geeignete Montageposition gefunden wurde. Schauen Sie auch auf unserer Webseite
unter www.eagletreesystems.com unter Flight Support - dort finden Sie Bilder von Installationen.

Zur Montage der Magnete miissen Sie zunachst einen geeigneten Einbauort an der Motorwelle/Antriebsstrang finden, um ein (oder
zwei) der kleinen Magnete und den Drehzahlsensor zu montieren. Typischerweise ist die Propellernabe oder -Abstandsscheibe ein
guter Montageort bei Flugmodellen, bei Automodellen ist es die Antriebswelle. Der am besten geeignete Montageort hangt natrlich
in erster Linie vom Modell ab. Stellen Sie sicher, dass der Montageort fiir die Magnete relativ stabil ist, damit diese bei ihrer Drehung
nicht den Drehzahlsensor oder andere Dinge im Modell beschadigen. Der Drehzahlsensor selbst muss fest montiert sein, der Abstand
zu den Magneten soll ca. 1 bis 2 mm betragen. Bei Flugmodellen ist es tblicherweise mdglich, den Drehzahlsensor mit der Riickseite
an eine glatte Oberflache Uber- oder unterhalb der Nabe, an der die Magnete befestigt sind, zu befestigen.

Das Drehzahl-Sensor-Kit enthalt 4 Magnete - das bedeutet geniigend Reserve, falls mal einer verloren geht!

Installation der Magnete

Zundchst missen Sie festlegen, wo Sie die Magnete/den Magneten zur ,Erzeugung” des Drehzahl-Messsignals befestigen mochten.
Die Magnete kdnnen entweder versenkt eingebaut oder an der drehenden Oberflache (Welle, Nabe) aufgeklebt werden. Bei einer
versenkten Montage muss - falls nicht schon vorhanden - eine Bohrung an der entsprechenden Stelle (Nabe) eingebracht werden.
Bei Klebemontage des/der Magnete auf der Nabe entfallt die Bohrung; diese Montageart ist zwar zeitsparender, falls sich aber die
beiden Magnete auf der Welle/Nabe nicht 180° versetzt gegeniiberstehen, besteht die Gefahr von Unwucht in der Welle!

Die versenkte Montage ist zwar aufwéndiger, dafiir ist aber die Gefahr von Unwuchten geringer. Zudem reicht bei Wellen/Naben aus
Metall meist ein einziger (!) Magnet als ,Signalgenerator” aus, da es bei dieser Montageart meist nicht zu einer Unwucht kommt.

Des weiteren ist die versenkte Montage robuster und fiir eine langfristige Montage besser geeignet.

Um die Magnete versenkt einzubauen, muss die Bohrung einen etwas groBeren Durchmesser haben als der gewdhlte Magnet hat. Die
Tiefe der Bohrung muss der Héhe des Magneten entsprechen.

Fir die Klebemontage der Magnete miissen Sie die Klebeflache sorgfiltig reinigen (z.B. mit Aceton oder Isopropylalkohol) und mit
Schleifpapier anrauhen, um die Klebwirkung zu maximieren.

Kleben Sie die Magnete mit der ROTEN Markierung nach innen (= hinterher nicht mehr sichtbar) auf die Welle bzw. in die Bohrung.
Als Kleber sollte Epoxy oder ein anderer geeigneter, stark haftender Klebstoff verwendet werden. Es ist wichtig, dass die rote
Markierung auf dem Magnet nach der Montage ,vom Sensor weg" zeigt. Die Magnete sollten im Abstand von 180° auf die Welle/Nabe
montiert werden, um Unwucht zu vermeiden.

WARNUNG:

Stellen Sie sicher, dass die Magnete wirklich fest auf der Welle aufgeklebt sind. Andernfalls besteht die Gefahr, dass sich die
Magnete l6sen und zu Verletzungen und anderen Schiden fiihren. Tragen Sie daher immer eine Schutzbrille, wenn sich der
Motor dreht! Es ist empfehlenswert, die Magnete mit weiteren MaBnahmen wie z.B. Klebeband oder Schrumpfschlauch zu

sichern.

Verwendung von vorhandenen Magneten

Hinweis:

Falls an Ihrem Motor / Welle / Antriebsstrang bereits Magnete montiert sind (aus welchem Grund auch immer) kénnen diese eventuell
zur Drehzahlmessung verwendet werden. Um festzustellen, wie in diesem Falle der Sensor montiert werden muss, tun Sie bitte
folgendes:

Nehmen Sie einen Magneten aus dem eLogger-Drehzahlsensor-Kit (RPM Kit) und halten Sie diesen an den schon vorhandenen
Magneten an Ihrem Motor (bzw. Welle / Antriebsstrang). Jetzt gibt es zwei Mdglichkeiten:

1.) Der eLogger-Magnet haftet mit der rot markierten Flache am montierten Magneten (d.h. die rote Markierung ist NICHT sichtbar).
In diesem Fall montieren Sie den Drehzahlsensor so, dass er mit der beschrifteten Seite zum bereits vorhandenen Magneten zeigt.

2.) Der eLogger-Magnet haftet am bereits vorhandenen Magneten, dass die rote Markierung SICHTBAR ist. In diesem Fall muss die
beschriftete Seite des Drehzahlsensors vom bereits montierten Magneten weg zeigen.
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Installation des Drehzahl-Sensors

Wenn die Magnete aufgeklebt sind und der Kleber ausgehartet ist, befestigen Sie den Drehzahlsensor provisorisch so, dass dieser mit
der beschrifteten Seite (bzw. der Seite, die mit einem Farbpunkt markiert ist), zum Magneten zeigt.

Als ndchstes muss der Sensor endgliltig montiert werden - dies geschieht ebenfalls durch Kleben. Um den Abstand zwischen Sensor
und Magnet von 1 mm - 2 mm einzuhalten, verwenden Sie wahrend der Montage bitte einen Abstandhalter mit der entsprechenden
Dicke.

Zur Montageerleichterung und zur besseren Stabilitdt kdnnen Sie ein Stlick Messing oder ein anderes nichtmagnetisches Profil an die
Ruckseite des Sensors befestigen (kleben).

Nachdem der Kleber ausgehdrtet ist, entfernen Sie den Abstandhalter zwischen Magnet und Sensor und priifen durch Drehen an

der Welle/Antriebsstrang, dass sich die Welle frei drehen ldsst. Priifen Sie auch, dass der Sensor fest fixiert ist damit er wahrend des
Betriebes nicht durch Vibrationen oder andere Bewegungen in Kontakt zu den Magneten kommen kann, da der Sensor ansonsten
zerstort wiirde und auch den eLogger beschadigen kann.

Wenn Sie all diese Schritte ausgefiihrt haben, schlieen Sie den Drehzahlsensor mit seinem Steckverbinder wie in Abbildung 1
gezeigt an den eLogger an. Falls eine Verlangerung des Sensorkabels nétig ist, kdnnen Sie dazu ein Standard ,Futuba” Servokabel

verwenden.

Verwendung vorhandener Drehzahlsensoren
Einige unserer Kunden haben den eLogger erfolgreich mit Drehzahlsensoren betrieben, die bereits im Modell installiert waren.
Dazu sind folgende Schritte nétig:

1. Ermitteln Sie die Pinbelegung des Sensorsteckers. Kompatible Sensoren missen einen Plus, einen Masse und einen Signal-Pin
haben. Die Pinbelegung des eLogger Drehzahlsensors ist: (von links nach rechts) Plus (Schwarze Leitung), Masse (Rote Leitung),
Signal (Weil3e Leitung).

2. Bauen Sie ein,Y" Kabel, um den vorhandenen Sensor sowohl an seinen urspriinglichen Anschluss wie auch an den Drehzahl-
Messanschluss des eLoggers anzuschlief3en.
HINWEIS: Vom bestehenden Sensor darf nur der Masse- und der Signal-Anschluss am eLogger angeschlossen werden!! Der
Sensor muss seine positive Betriebsspannung weiterhin vom urspriinglich vorhandenen Anschluss bekommen. Daher muss im
Y-Kabel die Verbindung der Betriebsspannung zwischen Sensor und eLogger unterbrochen werden, bevor es an den eLogger
angeschlossen wird!!

3. Testen Sie das System ausgiebig und sorgfaltig, um die gewiinschte Funktionalitdt (hauptsachlich die Funktion des Y-Kabels) sicher
zu stellen.

Installation eines sekunddren Drehzahlsensors
Ein zweiter, modifizierter(!) brushless Drehzahlsensor kann zum Erfassen einer weiteren Drehzahl am Gas-Servoanschluss
(Motorsteller) des eLoggers angeschlossen werden.

HINWEIS:

Nur ein brushless-Drehzahlsensor kann als sekundéarer Drehzahlsensor verwendet werden! Die optischen bzw. magnetischen
Drehzahlsensoren kdnnen NICHT als sekundare Drehzahlsensoren eingesetzt werden. Diese Sensoren werden zerstort, falls mit einem
anderen als dem RPM-Anschluss verbunden werden.

Um einen sekunddren Drehzahlsensor anzuschlieBen muss dieser (brushless Sensor) wie folgt modifiziert werden:

« Biegen Sie vorsichtig die Plastik-Nasen auf, die zur Fixierung des ROTEN und SCHWARZEN Kontakts im Sensorstecker dienen und
entfernen Sie die Kontakte aus dem Steckergehause.

« Bringen Sie den ROTEN Kontakt an die Stelle des SCHWARZEN Kontaktes; die Reihenfolge der Kontakte im Stecker ist nun:
rot, nicht belegt, weiss

+ Der sekunddre Drehzahlsensor wird am eLogger auf den Throttle (Fahrtregler) Steckverbinder aufgesteckt; die rote Leitung muss in
Richtung der Beschriftung am eLogger zeigen.

« Der schwarze Kontakt (der sich nicht mehr im Steckergehause befindet) muss an den oberen ,, Tmp3” Pin angeschlossen werden.

HINWEIS:

Es ist wichtig, dass der primdre und sekundare Drehzahlsensor vom gleichen Typ sind, da der sekundére Drehzahlsensor vom System
automatisch mit dem gleichen,,Ubersetzungsverhiltnis” wie der primére eingerichtet wird. Ein optischer Drehzahlsensor darf also
nicht gemeinsam mit einem brushless-Sensor betrieben werden.

Weiter unten wird beschrieben, wie die Darstellung und Abspeicherung der Daten des zweiten Drehzahlsensors erfolgt.
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Uberwachung der Position des Gas-Servos Ihres Modells

Anschluss des Fahrtregler Y-Kabels am Fahrtregler und eLogger

WICHTIG:

Schlief3en Sie lhren Antriebsakku erst dann an den E-Logger an, wenn Q~-—|—_:) _

alle anderen Verbindungen bereits bestehen (z.B. Gasservo bzw. /| “\x\\

Motorsteller mittels Y-Kabel). Servg RX
Der eLogger zeichnet die Servostellung durch Messung der Empfanger- Trally

Impulse Gber das optionale Y-Kabel auf. Das Y-Kabel hat drei Anschlisse.

Der ,Futuba” Stecker (ménnlich) wird -wie in der Abbildung gezeigt- an

den eLogger angeschlossen. Die universellen Stift-/ Buchsenkontakte des \ /
Y-Kabels werden an den Fahrtregler Ausgang bzw. den Servo-Eingang [
des Empfangers a“ngeschlossgn. Abbildung 2 zeigt den Anschluss des Abbildung 2 ¥-Cable
Y-Kabels an Empfanger (Receiver) und Servo.

Bei Anschluss des Y-Kabels an den Empfanger wird eine

Masseverbindung zwischen Akkupack und Empfanger hergestellt,

die auch mit dem eLogger verbunden ist. Dies fiihrt zur galvanischen Ta elagge:
+Uberbriickung” einer eventuell vorhandenen Isolation (z.B.

Optokoppler) der Massen von Controller und Empfanger. Wir

haben bisher keine Informationen liber Fehlfunktionen erhalten, die durch eine Verbindung der Akku-Masse mit der Empfanger-
Masse hervorgerufen wurde. Nichts desto trotz sollten Sie vorsichtig sein, da eine solche Verbindung eventuell eine Fehlfunktion
Ihrer Hardware ausldsen kdnnte. Bitte fiihren Sie daher nach Anderungen an der Hardware eine Reichweiten-Uberpriifung der
Fernsteuerung lhres Modells durch.

Installation und Benutzung der Windows Anwendungssoftware

Installation der Software (nur Windows)

Die Mitgelieferte Windows-Software ist mit PCs kompatibel, die unter Vista, XP, Win98 SE, Millenium oder Win 2000 laufen und eine
USB Schnittstelle besitzen. Die Software ist nicht kompatibel mit der urspriinglichen Version von Windows 98 (Gold) oder NT4, selbst
wenn der entsprechende PC eine USB Schnittstelle hat.

HINWEIS:
Die mitgelieferte Software-CD enthalt evtl. nicht mehr die aktuellste Version der Software. Bitte schauen Sie unter Support auf unserer
Webseite www.eagletreesystems.com nach, ob eventuell bereits eine aktuellere Version der Software verfligbar ist.

Um die Software zu installieren legen Sie bitte die CD in Ihr CD/DVD Laufwerk des PCs ein. Wenn die Autoplay Funktion aktiviert ist,
startet die Installation der Software automatisch. Falls dies nicht der Fall ist, 6ffnen Sie bitte den Windows Explorer, suchen das CD/DVD
Laufwerk und starten dort die Datei setup.exe mit Doppelklick.

Folgen Sie den Anweisungen des Installationsprogramms . Wenn die Installation beendet ist, kbnnen Sie die eLogger Software
entweder mit deren Desktop-Symbol oder tiber das START Menl (Start>Programme>Eagle Tree Systems) starten.

Setup des eLoggers mit Hilfe der Software
Um die Anwendung zu starten, gehen Sie bitte wie vorher beschrieben vor. Beim erstmaligen Aufruf des Programms wird der Neue
Hardware Wizard aktiviert. Der Wizard fordert Sie dazu auf, den eLogger mit dem beiliegenden USB Kabel an den PC anzuschlief3en.

WICHTIG:

Stellen Sie sicher, dass Sie das USB Kabel korrekt auf den entsprechenden Steckverbinder des eLoggers aufschieben (wie in
Abbildung 1 ersichtlich). Bei erstmaliger Durchfiihrung der Aktion wird je nach verwendeter Windows Version etwas anderes
geschehen:

Windows 98: der eLogger ist NICHT kompatibel mit der Originalausgabe von Win98

Win98 SE, Windows Millenium (ME):

Wenn der eLogger zum ersten mal an den PC angeschlossen wird, erscheint der,Neue Hardware gefunden” Wizard. Befolgen Sie
Anweisungen des Wizard, um es Windows zu ermdglichen, die entsprechenden Treiber fiir den eLogger zu finden und zu installieren;
diese Treiber sind in Windows integriert. Falls sich diese Treiber nicht auf ihrer Festplatte befinden sollten, werden Sie aufgefordert,
die Windows Installations CD einzulegen um die entsprechenden Treiber von dort zu kopieren. Am ende dieses Vorgangs werden Sie
eventuell aufgefordert, den PC neu zu starten. Nach einem Neustart und dem erneuten Start der eLogger Software sollte auch der
»Neue Hardware” Wizard erneut starten.

Windows Vista, Win 2000, Win XP:

Bei Anschluss des eLoggers an den USB Port des PCs installiert Windows automatisch die entsprechenden Treiber, ohne dass

Sie interagieren mussen. Falls wahrend der Installation dennoch eine Meldung angezeigt wird, befolgen Sie diese bitte wie dort
beschrieben.

Wenn der eLogger von Windows korrekt erkannt und installiert wurde, fahren Sie mit dem Neue Hardware gefunden Wizard fort;
eventuell ist dazu ein Neustart und ein erneuter Start der eLogger Software nétig.
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So stellen Sie ein, was der eLogger aufzeichnen soll
Beim ersten Start der Software werden Sie dazu aufgefordert die Parameter auszuwdhlen, die aufgezeichnet (geloggt) werden sollen.
Je mehr Parameter Sie auswahlen, desto weniger Aufzeichnungszeit ist verfligbar. Hier eine Auflistung der moglichen Parameter:

Electric Motor Voltage (Spannung am Elektromotor) : Aufzeichnung der Akkuspannung

Electric Motor Current (Strom durch den Elektromotor) : Aufzeichnung des Akkustroms

RPM Sensor A (Drehzahlsensor A): Aufzeichnung des Drehzahlverlaufs (nur mit installiertem Drehzahlsensor)

Temperature 1 (Temperatur 1): Wahlen Sie diese Option, wenn Sie die Temperatur eines optionalen Temperatursensors aufzeichnen michten
Temperature 2 (Temperatur 2): Zur Aufzeichnung der Temperatur eines zweiten optionalen Temperatursensors

Temperature 3 (Temperatur 3): Zur Aufzeichnung der Temperatur eines dritten optionalen Temperatursensors

Position des Gas-Servos (Motorsteller): Aufzeichnung der Position des Gasservos bzw. des Motorstellers (optionales Y Kabel wird bendtigt)
Airspeed (Fluggeschwindigkeit): Aufzeichnung der Fluggeschwindigkeit mit dem optional erhdltlichen Fluggeschwindigkeits-Sensor
Altitude (Hohenmessung): Aufzeichnung der Fluggeschwindigkeit mit dem optional erhéltlichen Héhenmess-Sensor

Servo Current (Servo Strom): Aufzeichnung des Servo-Stroms mit dem optional erhaltlichen Servo-Stromsensor

All GPS Parameters (Alle GPS Parameter): Aufzeichnung aller GPS Positionsdaten mit dem optionalen GPS Expander

Spektrum AR9000 Flight Log Interface: Aufzeichnung der Empfanger-Leistungsdaten (Ar9000 oder JR 921) mit optionalem Spektrum Kabel

Einstellen des Features ,Stop on Full*
(Aufzeichnung bei vollem Speicher beenden)

Wenn der Neue Hardware Wizard zum ersten mal ausgefiihrt wurde, werden Sie aufgefordert einzustellen was geschehen soll, wenn
der Pufferspeicher des eLoggers voll ist.

Es stehen zwei Méglichkeiten zur Auswahl:
1) Write Over Data (Uberschreiben des Speichers)
2) Stop on full (Datenaufzeichnung beenden, wenn Speicher voll)

HINWEIS:
Diese Einstellung kann auch im Nachhinein iber das Meni Tools gedndert werden. Wenn der Speicher voll ist, wird dies bei der
Einstellung Stop on Full durch das zweimalige Aufblitzen der Status LED am eLogger signalisiert.

Einstellen der Datenrate der Aufzeichnung (Set Capture Rate)

Der eLogger kann auf fiinf verschiedene Datenraten zur Aufzeichnung der Messwerte eingestellt werden. Je héher die Datenrate
(Capture Rate), desto schneller werden die Messungen durchgefiihrt und gespeichert — dafiir verringert sich die Aufzeichnungsdauer,
je hoher die gewahlte Datenrate ist. Die voreingestellte Datenrate von 10 Messungen/Sekunde (Samples/Sec) bedeutet eine sehr
genaue Auflésung, dafir ist Aufzeichnungsdauer kiirzer als mit kleineren Einstellungen der Datenrate. Aber auch mit einer hohen
Datenrate ist die Aufzeichnungsdauer meist ausreichend.

HINWEIS: Diese Einstellung kann auch im Nachhinein tGiber das Menii Tools gedndert werden.

Noch ein Hinweis zur Aufzeichnungsdauer:

Beim eLogger werden die erfassten Daten komprimiert abgespeichert, um mdoglichst viele Datensatze zu erfassen. So lange die
Stromversorgung Ihres Modells eingeschaltet ist, werden auch vor- und nach dem ,Messflug” Daten vom eLogger aufgezeichnet.

Da sich in diesem (Ruhe-)Zustand des Modells aber nur sehr wenige Messwerte andern (wenn Gberhaupt!) wird auch nur eine sehr
geringe Datenmenge erfasst. Im ,normalen” Betrieb des Modells (z.B. Flug) wird eine wesentlich gréBere Datenmenge aufgezeichnet.

Auswahl der Daten, die auf dem PC dargestellt werden sollen
(Choose What to Display on the PC Screen)

Die eLogger Software kann verschiedene Parameter sowohl in numerischem Format wie auch in Instrumentenform (analog)
darstellen. Wahlen Sie die Parameter, die Sie angezeigt haben mdchten in der Dialogbox. Beachten Sie, das einige der Parameter nur
mit optionalem Zubehor gemessen (und somit auch dargestellt) werden kdnnen. Zubehor kdnnen Sie bei Eagle Tree Systems oder
unseren Distributoren erwerben.

HINWEIS:
Zum Umschalten auf metrische MaBeinheiten aktivieren Sie bitte die Checkbox mit der Beschriftung Metric. Diese Einstellung kann
auch im Nachhinein tiber das Menii Tools gedndert werden.
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Konfiguration und Kalibrierung der Fahrtregler-Funktion in der Software
(Configuring and Calibrating Throttle Function)

Es ist nicht unbedingt notwendig, die Fahrtregler-Funktion zu kalibrieren. Der Vorteil einer Kalibrierung ist die genauere grafische
Darstellung des gesamten Bereiches der Fahrtregler-Position von Null (,kein Gas”) bis 210 (,Vollgas”). Ohne Kalibrierung wird zwar
die Bewegung des Fahrtreglers immer noch dargestellt, aber es kann sein, das die Darstellung ,invertiert” erfolgt und/oder nicht den
gesamten Bereich von 0 bis 210 abdeckt.

Um den Fahrtregler ihres Modells fiir die korrekte Darstellung zu kalibrieren, schlieBen Sie bitte das Y-Kabel wie vorher erwdhnt an und
verbinden Sie dann den eLogger lber das USB Kabel mit lhrem PC. Klicken Sie dann auf,Tools>Calibrate Throttle” und befolgen Sie
die Anweisungen des Calibrate Throttle Wizards.

Einsatz des eLoggers
Wenn der eLogger im Modell und die Software auf dem PC installiert ist, kann es endlich los gehen!
Bitte lesen Sie hier vorher noch die wichtigen Informationen zum eLogger, bevor Sie diesen in Ihrem Modell verwenden.

Es ist sehr unwahrscheinlich, das der Einbau des eLoggers die Reichweite lhres Modells (Fernsteuerung) beeinflusst. Aber wie bei jeder
Anderung / Umbau an Ihrem Modell ist es auch hier sehr wichtig, das Sie alle Funktionen vor dem Einsatz lhres Modells sorgfiltig
und ausgiebig liberpriifen, damit Sie sicher sein kdnnen, das der Einbau des eLoggers keinen negativen Einfluss auf lhr Modell hat.

Auch sollten Sie sicherstellen, dass die Energieversorgung lhres Systems nach Einbau des eLoggers fehlerfrei arbeitet. Dies ist
insbesondere bei Modellen mit hohen Akkuspannungen und -Stromen wichtig, da ja der eLogger in Reihe zum Akkupack
geschaltet ist. Daher sollten Sie einen stationdren Belastungstest mit lhrem Modell durchfiihren, bei dem Sie ihr Modell
adhnlichen Belastungen wie beim tatsdchlichen Flug aussetzen. Nur so konnen Sie Probleme in der Verkabelung bzw. den
Steckverbindern feststellen, ohne das Modell zu gefahrden.

Die LED Anzeigen des eLogger

Die LEDs am eLogger geben Auskunft tiber den Status des Gerétes.

Wenn der eLogger an die Stromversorgung in lhrem Modell angeschlossen ist, blinken seine LEDs um bestimmte Zustéande zu
signalisieren. Die Anzahl und die Frequenz der Blinkimpulse gibt Auskunft Gber den Betriebszustand.

Einmaliges Blinken - der eLogger zeichnet Daten auf. Dies ist der normale Zustand, sobald der eLogger mit Strom versorgt wird.

Zweimaliges Blinken — der Speicher im eLogger ist voll, oder sie haben,Logging Trigger” aktiviert und der Logger ist noch nicht
getriggert. Bitte beachten Sie, das der eLogger die Aufzeichnung bei vollem Speicher nur dann stoppt, wenn Sie den Stop on Full
Modus (wie weiter oben beschrieben) aktiviert haben.

Dreimaliges Blinken — der eLogger ist mit dem USB Kabel an einen PC angeschlossen und wurde von diesem erkannt

Nach Aufzeichnung der Daten

Nachdem Sie die Daten Ihres Modells mit dem eLogger aufgezeichnet haben, kdnnen Sie zur Auswertung den eLogger entweder
ausbauen und mit Ihrem PC verbinden, das Modell mit dem eingebauten eLogger zum PC bringen und diesen per USB mit dem PC
verbinden oder einen Laptop zum Auslesen der Daten aus dem eLogger verwenden.

Nachdem Sie den eLogger per USB Kabel an den PC angeschlossen haben, sollte die Status-LED durch dreimaliges blinken
signalisieren, dass eine Verbindung zwischen eLogger und dem PC besteht (siehe oben).

Nun missen Sie die eLogger Software auf lhrem PC starten und auf den Download Button klicken. Dadurch werden die im eLogger
gespeicherten Daten zum PC Ubertragen. Dort kdnnen Sie die Daten dann analysieren und abspeichern.

Klicken Sie auf die Schaltfliche Play, um die Daten anzuschauen. Den Schieberegler kdnnen mit der Maus hin- und herziehen, indem
Sie darauf klicken und ihn an die entsprechende Position ziehen.

Die Software kann folgende Daten darstellen:

H Notifications (Meldungen) —in diesem Fenster werden Daten iiber die Aufzeichnung angezeigt. Die drei haufigsten Meldungen sind:
- Startup / Reset detected - zeigt an, wann der eLogger eingeschaltet wurde
- eLogger low battery restart — bedeutet, dass der eLogger neu gestartet wurde, weil die Spannung unter einen Wert von 4,5 Volt abgefallen ist.
Lesen Sie im Abschnitt Fehlerbehebung nach, falls diese Meldung 6fter erscheint

B Length/Progress — (Aufzeichnungsldnge/Position) - zeigt die Zeitdauer der Aufzeichnung an. Beim,, Abspielen” der Daten wird die aktuelle Position
in der Aufzeichnung angezeigt

W Graphical and/or Numeric Pack Voltage — die Software zeigt die aktuelle (bei angehaltener Datenwiedergabe) oder maximale Akkuspannung
in analoger oder numerischer Form an.

W Graphical and/or Numeric Pack Current - die Software zeigt den aktuellen (bei angehaltener Datenwiedergabe) oder maximale Akkustrom
in analoger oder numerischer Form an.
W Pack Wattage — Anzeige der elektrischen Leistung
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B Cumulative Amp-Hours — Kumulative Anzeige des Ah Wertes in numerischer Form

W Graphical and/or Numeric Temperatures — Die Software kann bis zu zwei Temperaturen gleichzeitig darstellen
(numerische Darstellung oder Darstellung als Zeigerinstrument)

W Graphical and/or Numeric RPM — Darstellung der Drehzahl als numerischer Wert oder in Form eines Zeigerinstrumentes

W Graphical and/or Numeric Speed (Cars only) — Errechnete Geschwindigkeit (nur bei Automodellen) als numerischer Wert oder in Form eines Zeigerinstrumentes.

Unterstiitzung mehrerer ,Sessions"

Abhéngig von der Dauer ihrer Modell-“Sessions” ist es oftmals mdglich, mehr als nur eine Datenaufzeichnung durchzufiihren, ohne
dass Sie den Speicher des eLoggers auslesen missen. Der eLogger trennt die einzelnen ,Sessions” automatisch voneinander. Wenn Sie
im Fenster Playback (Datenwiedergabe) oder Graphing (grafische Darstellung) die Option Sessions anklicken, kdnnen Sie zwischen
der Darstellung einer einzelnen Session und der Gesamtansicht (alle Sessions gleichzeitig) umschalten. Bei der Gesamtansicht wird der
Beginn einer neuen Session durch vertikale graue Balken markiert.

Jedes mal, wenn Sie den eLogger einschalten (Spannung anlegen), wird eine neue Session erstellt.

Abspeichern der eLogger Log-Dateien

Nachdem Sie die Daten der Sessions vom eLogger in lhren PC geladen haben, kdnnen Sie diese abspeichern, um auch in Zukunft
darauf zugreifen zu konnen. Dies geschieht mit der Option ,File>Save Recorder File". Die Datei wird mit der Erweiterung .FDR
abgespeichert.

USB Live-Modus

Wenn der in lhrem Modell eingebaute eLogger eingeschaltet und gleichzeitig tiber USB mit Ihrem PC verbunden ist, werden durch
anklicken von Live Mode in der eLogger Software die gemessenen Daten (nahezu) in Echtzeit am Computerbildschirm angezeigt
(sowohl die numerischen Daten als auch die analoge Instrumentendarstellung). Die angezeigten Daten konnen auf dem PC
aufgezeichnet werden. Dazu Wahlen Sie bitte , Tools>Set Live Mode Options”. Bei beenden des Live Mode mit dem Stop-Button
werden Sie gefragt, ob die Daten abgespeichert werden sollen.

Im Live-Mode wird auch die ,Endlose” Darstellung der Messdaten unterstiitzt. Um diese Anzeigeart zu aktivieren, Sie bitte zundchst
auf Live Mode Recording um. Klicken Sie dann auf Graph Data um die grafische Darstellung zu aktivieren. Wahlen Sie die Parameter,
die grafisch angezeigt werden sollen und klicken Sie danach auf den Live Mode Button. Nun werden die Daten in Echtzeit grafisch
dargestellt.

Grafische Darstellung / Datenexport

Die eLogger Software bietet eine Vielzahl von grafischen Darstellungsméglichkeiten. Klicken Sie einfach auf Graph Data! in
der Toolbar, um die grafische Darstellung der Daten zu aktivieren. Uber die Hilfe (Help) Funktion erfahren Sie weiteres zu den
Méglichkeiten der grafischen Darstellung (in englischer Sprache).

Die aufgezeichneten Daten in der eLogger Software sind kompatibel mit Tabellenkalkulationsprogrammen (z.B. Excel, OpenOffice). Mit
Excel konnen die aufgezeichneten Daten des eLoggers auch grafisch dargestellt werden.

Um die Daten in Excel zu laden, speichern Sie die Daten aus dem eLogger mit dem Befehl ,File>Save Recorder File” ab, 6ffnen
Excel und wahlen dort,Datei>6ffnen’, wahlen ,Alle Dateien” im Dialogfeld ,Dateityp”. Suchen Sie die zuvor gespeicherte Datei
(mit der Endung .FDR), und klicken Sie auf diese Datei. Excel sollte dann den ,Text Import Assistent” starten. Wahlen Sie die Option
~getrennte Zahlenwerte“und im ndchsten Feld wahlen Sie ,durch Leerzeichen getrennt”. Die Daten sollten dann korrekt in Excel
importiert werden.

Das Datenformat jeder Zeile ist:

Erste Zeile: Modellname

Zweite Zeile: Daten lhres Modells. Diese Information ist ntig, um die Daten mit anderen Modellen vergleichen zu kénnen.
Dritte Zeile: Kopfzeile zur Identifikation der Information, die sich in den Spalten befindet. Die Spalten sind:

Milliseconds IsEvent EventError EventData Altitude Airspeed ServoCurrent*100 Throttle PackVolt*100 Amps*100
Temp1*100 Temp2*100 Temp3*100 RPM RPM2 GPSLat GPSLon GPSAlt GPSSpeed GPSCourse GPSDist GPSUTC
NumSats GPSFlags

Wenn IsEvent den Wert 1 hat, enthalten die aufgezeichneten Daten sowohl Event- Daten (Ereignisse) als auch reguldre Daten. Typische
Events (Ereignisse) sind Power-up (Einschalten) und Servo glitches (Stérimpulse). Sie kénnen die, ,non-event” Felder ignorieren, wenn
IsEvent den Wert 1 enthalt.

Event Codes im ,Event Code” Feld sind folgendermafen definiert. Bitte melden Sie Codes, die hier nicht aufgefiihrt sind umgehend an
Eagle Tree Systems:

© 2008 by Eagle Tree Systems LLC / EMCOTEC GmbH Seite 8



Bedienungsanleitung eLogger V3

9 =ERROR_RESTART: der eLogger wurde eingeschaltet oder neu gestartet
18 = ERROR_GPS_DATA_PACKET : Es wurden GPS Daten vom GPS Expander empfangen
27 = ERROR_SPEKTRUM_DATA_PACKET : Es wurden Daten vom AR9000 Interface Empfangen

Milliseconds (Millisekunden) gibt an, wann der entsprechende Datensatz aufgezeichnet wurde, beginnend vom Einschaltzeitpunkt
des eLoggers.
Senden Sie uns eine E-mail, falls Sie ndhere Informationen zum Datenformat bendtigen.

Fehlerbehebung

Hier finden Sie eine Auflistung von moglichen Problemen und wie Sie diese beseitigen konnen.

In jedem Falle sollten Sie bei Problemen priifen, ob Sie die aktuellste eLogger Firmware verwenden. Um die Firmware auf den
aktuellsten Stand zu bringen, schlieBen Sie Ihren eLogger an einen PC mit Internetzugang an und wahlen in der eLogger Software den
Mentipunkt,Tools>Firmware Control” aus.

Falls der Fehler nach einem Firmware-Update bzw. denn Tipps weiter unten weiterhin besteht, besuchen Sie bitte unsere Webseite,
um weitere Unterstiitzung zu erhalten.

Die Webadresse lautet: www.eagletreesystems.com/Support/support.html

Fehler: Der eLogger wird nicht von meinem PC erkannt.

Losung:

« Versuchen Sie, das Problem folgendermafen zu beheben:

+ Trennen Sie nach Mdglichkeit alle anderen USB Gerate von lhrem PC und versuchen Sie den eLogger erneut zu starten

« Versuchen Sie, den eLogger an einem anderen PC in Betrieb zu nehmen. Es kdnnte sein, dass lhr PC nicht korrekt konfiguriert ist.

« Verwenden Sie ein anderes USB Kabel, falls Sie eines zur Hand haben. Falls es mit einem anderen USB Kabel Funktioniert, ist das
urspriingliche USB Kabel wahrscheinlich defekt.

- Starten Sie lhren PC neu.

« Verwenden Sie eine andere USB Buchse an lhrem PC, falls dieser mehr als eine USB Buchse hat.

« Uberpriifen Sie im Gerite Manager |hres Betriebssystems, dass die USB Unterstiitzung eingeschaltet ist. Verwenden Sie die Hilfe-
Funktion von Windows, falls Sie nicht Wissen, wie Sie den Gerate-Manager 6ffnen kdnnen.

Fehler: Drehzahlmessung funktioniert nicht korrekt. (Lesen Sie hierzu bitte auch den Abschnitt iiber optische/ brushless Drehzahlsensoren

in dieser Anleitung)

Losung:

« Falls Sie den magnetischen Drehzahlsensor verwenden priifen Sie bitte, ob der Abstand zwischen Magnet und Sensor zwischen
1 mm und 2 mm betragt.

« Prifen Sie die Polung der Magnete/des Magnetes. Der/die Magnete mussen so befestigt sein, dass die rote Markierung auf dem
Magnet NICHT sichtbar ist. Die Beschriftung auf dem Drehzahlsensor muss in Richtung des Magneten zeigen.

« Falls Sie feststellen, dass Sie den Magneten so befestigt haben, dass die rote Markierung SICHTBAR ist, montieren Sie bitte den
DrehzahISENSOR so, dass die UNbeschriftete Seite zum Magneten zeigt.

« Stellen Sie sicher, das Sie in der eLogger Software angegeben haben, dass Sie die Drehzahl (RPM) messen méchten

« Priifen Sie, dass der Stecker des Drehzahlsensors in der richtigen Position am eLogger aufgesteckt ist.

« SchlieBen Sie den eLogger am PC an und starten Sie die eLogger Software auf dem PC. Wahlen Sie dann ,Tools>Live Mode".
Schauen Sie, dass das Drehzahl-“Messinstrument” angezeigt wird und drehen Sie die Welle, an der die Drehzahl gemessen werden
soll. Alternativ kdnnen Sie auch einen Magneten vor dem Sensor hin- und herbewegen. Fiihren Sie diesen Test mit beiden Polen des
Magneten und auf beiden Seiten des Sensors durch. Beobachten Sie dabei das Drehzahl-Messinstrument auf dem Bildschirm.

Fehler: Mein Akkupack ist voll geladen, aber der eLogger bringt regelmdBig die Meldung ,Low Battery Restart” (Neustart wegen zu geringer

Akkuspannung) in den aufgezeichneten Daten.

Losung:

Der eLogger deaktiviert sich selbststandig, falls die Betriebsspannung fiir mehrere Millisekunden unter etwa 5 Volt absinkt. Wenn die

Spannung danach wieder Uiber 5V ansteigt, wird dieses Ereignis im eLogger abgespeichert. Falls dies 6fter vorkommt, ist es moglich,

dass Ihr Akkupack nicht genligend Energie liefert und Sie evtl. einen starkeren Akkupack einsetzen sollten.
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Fehler: Dievom elogger aufgezeichneten Strom- oder Spannungswerte scheinen nicht korrekt zu sein.

Losung:

- Stellen Sie sicher, dass Sie alle Messwerte, die aufgezeichnet werden sollen, in der Software unter,Tools>Choose Parameters to be
logged in Recorder” ausgewahlt haben.

« Falls der gemessene Strom Fehlerhaft erscheint, schlieen Sie den Akkupack an den eLogger an und danach den eLogger an die USB
Schnittstelle Ihres PC. Dann wéhlen Sie in der eLogger Software ,Tools>Rezero Current Sensors” um die Stromsensoren auf Null
zu setzen. Stellen Sie sicher, dass bei diesem Vorgang keine andere Last (Controller etc.) am eLogger angeschlossen ist. Diese
+Nullung” der Stromsensoren wird vor dem Versand zwar auch bei uns durchgefiihrt, aber es kann vorkommen, dass eine Drift nach
einigen Betriebsstunden eine erneute Nullung der Stromsensoren erforderlich macht.

« Falls Sie den Eindruck haben, dass die Messwerte nach erfolgter Nullung der Stromsensoren immer noch nicht in Ordnung sind oder
wenn die Spannungsanzeige einen anderen Wert anzeigt als z.B. ein parallel geschaltetes Voltmeter, so kdnnen Sie die Messwerte
per Software auf den gewlinschten Wert kalibrieren. Dies geschieht in der eLogger Software mit der Auswahl von ,Tools>Calibrate

Pack Voltage and Amperage” und der Eingabe der Werte auf lnrem Messgerat und der Messwerte des eLoggers. Falls Sie nur die
Werte flr die Strom-Messung Kalibrieren méchten, so geben Sie in den eFeldern fiir die Spannungsmessung bitte den Wert, 0" ein
- dann wird der Spannungsmesswert nicht kalibriert! Der eLogger wird wahrend der Produktion mit hochgenauen Strom- und

Spannungsmessgeraten kalibriert.

« Falls Ihnen die Mess-Ungenauigkeiten bei der Strom-/Spannungsmessung sehr grof3 vorkommen, sollten Sie zunachst die
Kalibrierung vollstandig I6schen. Dies geschieht durch starten des Kalibrierungs-Tools wie weiter oben beschrieben, wobei Sie aber
fur die ,problematischen” Messergebnisse die gleichen Werte eingeben. BEISPIEL: Wenn die Strommessung ungenau ist, geben Sie
sowohl flir den ,eLogger-Wert” als auch fiir den,,my amperage” Wert die Zahl 5.0 ein. Dies 16scht sowohl die internen- als auch die

Benutzer-Kalibrierungsdaten.

("ACHTUNG !! : Kommastellen in der Software diirfen nicht als Komma, sondern miissen als Punkt (.) eingegeben werden
- dies ist die amerikanische/englische Schreibweise!)

Fehler: Temperatur-Messwerte scheinen nicht korrekt zu sein

Losung:

Stellen Sie sicher, dass Sie alle Messwerte, die aufgezeichnet werden sollen, in der Software unter,Tools>Choose Parameters to be

logged in Recorder” ausgewahlt haben.

Fehler: Fahrtregler-Bewegungen sind nicht korrekt/ Fahrtregler kann nicht kalibriert werden

Losung:

Priifen Sie, dass Sie das Y-Kabel wie in Abbidung 1 gezeigt angeschlossen haben
Flhren Sie die Fahrtregler-Kalibrierung durch, wie in dieser Anleitung beschrieben.
Priifen Sie, dass die Messwerte fiir die Fahrtregler-Stellung im eLogger auch aufgezeichnet werden

Technische Daten des eLogger

Spannungsmessung:

5Vbis70V

Auflésung im Spannungsmessbereich:

0,02V

Strom-Messung:

bis zu 100 A (150 A mit MPRV3-LEADS-150)

Auflésung im Strom-Messbereich:

0,02 A (0,035 A mit MPRV3-LEADS-150)

Strom-Eigenverbrauch:

ca. 30 mA, ohne Sensoren

Gewicht:

Mit integrierten Anschlusskontakten: ca. 20 Gramm
Mit Anschlussleitungen (100 A Version) : ca. 25 Gramm

Temperaturmessbereich:

-18° C bis +218° C (drei Eingange fiir Temperatursensoren)

Drehzahlmessbereich:

ca. 100 1/min bis >50.000 1/min

Einheit der Messgrof3en:

Metrisch oder Englisch

Abmessungen:

57 mm x 28 mm x 13 mm, einschlief3lich Anschlusskontakte

Kabelldnge bei der bekabelten Version:

65 mm

Aufzeichnungsdauer:

Hangt von der Datenrate, den aufzuzeichnenden Parametern und
der ,Aktivitat” des Modells ab. Zwischen 45 Minuten bis hin zu
mehreren Stunden, abhdngig von den gewahlten Einstellungen.
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Eingeschrankte Gewahrleistung

Eagle Tree Systems, LLC garantiert fiir die Dauer von einem Jahr ab Kaufdatum, dass der eLogger frei von Materialfehlern oder
Fertigungsfehlern ist. Diese Garantie ist NICHT tibertragbar. Falls Ihr Produkt wahrend dieser Zeit einen der vorgenannten Fehler
aufweist und daher an unseren Service (ibergeben wird, obliegt es unserer Entscheidung, ob das Produkt repariert oder ersetzt wird.
Versandkosten des Produktes zu uns geschieht auf Ihre Kosten.

Um Garantie-Service zu erhalten, fordern Sie bitte telefonisch, per Fax oder E-mail eine RMA Nummer an. Riicksendungen ohne RMA

Nummer werden nicht angenommen.

Die eingeschrankte Gewdhrleistung schlie3t folgende Dinge aus:

Die mit dem eLogger gelieferte Software. Details entnehmen Sie bitte den Linenzvereinbarungen (Software License agreement)
Probleme und Fehler, die von folgenden Dingen verursacht werden

Externe Ereignisse wie Unfall, zweckfremde Verwendung, Stérungen in der Stromversorgung

Nicht durch uns autorisierte Reparaturen / Service

Einsatz/Verwendung in einer Art, die nicht mit der Anleitung konform ist

Fehler und Probleme, die durch Missachtung der Anleitung entstehen

Nachfolgend der englische Text der weiteren Garantiebestimmungen:

THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM
STATE TO STATE (OR JURISDICTION TO JURISDICTION). OUR RESPONSIBILITY FOR MALFUNCITONS AND DEFECTS IN
HARDWARE IS LIMITED TO REPAIR AND REPLACEMENT AS SET FORTH IN THIS WARRANTY STATEMENT. ALL EXPRESS

AND IMPLIED WARRANTIES FOR THE PRODUCT, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES AND
CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE LIMITED IN TIME TO THE TERM OF
THE LIMITED WARRANTY PERIOD AS DESCRIBED ABOVE. NO WARRANTIES, WHETHER EXPRESS OR IMPLIED, WILL APPLY
AFTER THE LIMITED WARRANTY PERIOD HAS EXPIRED. SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN
IMPLIED WARRANTY LASTS, SO THIS LIMITATION MAY NOT APPLY TO YOU. WE DO NOT ACCEPT LIABILITY BEYOND THE
REMEDIES PROVIDED FOR IN THIS LIMITED WARRANTY OR FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, INCLUDING,
WITHOUT LIMITATION, ANY LIABILTY FOR THIRDPARTY CLAIMS AGAINST YOU FOR DAMAGES, FOR PRODUCTS NOT BEING
AVAILABLE FOR USE, OR FOR LOST DATA OR LOST SOFTWARE. OUR LIABILITY WILL BE NO MORE THAN THE AMOUNT
YOU PAID FOR THE PRODUCT THAT IS THE SUBJECT OF A CLAIM. THIS IS THE MAXIMUM AMOUNT FOR WHICH WE ARE
RESPONSIBLE. SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL
DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

Reng trieren Sie ihren eLogger

Wenn Sie lhr Produkt registrieren, kdnnen wir Ihnen wichtige Updates und weitere Informationen zusenden.
Bitte senden Sie folgende Informationen per E-mail an: sales@eagletreesystems.com
NAME:

ADDRESS: (Strasse / PLZ / Ort)

COUNTRY (Land):

Phone / Tel.:

Email:

Products Purchased (gekaufte Produkte)

Date Purchased (Kaufdatum)

Where did you purchase your product / wo haben Sie das Produkte gekauft:

Where did you hear about our product / Wie haben Sie von unserem Produkt erfahren:

Exklusiv-Vertrieb in Deutschland:

EMCOTEC GmbH
WaldstraBle 21

86399 Bobingen

Tel. (+49) 08234 /95 98 950
Fax (+49) 08234 /9598 959

Internet www.emcotec.de
www.rc-electronic.com

© 2008 by Eagle Tree Systems LLC / EMCOTEC GmbH Seite 11



